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Software version: Asanti 2.0

Tutorial WOI‘kﬂOW automation HOt TiCketS Document version: June 23, 2015

This tutorial demonstrates how to use Digital printing Hot Tickets in Asanti 2.0.
Download the Asanti Sample Files via the Asanti Client (Help > Asanti Online > Download Sample Files).

1. Hot Tickets for manual placement

Create Hot Ticket

1. Click the Hot Tickets link at the bottom of the client window to :A Templates - APESX1S8 L& |

navigate to the Hot Tickets window. e |

. . . . Ti

2. In the Hot Tickets window, select File > New Layout Hot Ticket. fm ] — .

e Select Category Asanti. I - Cotegory 4t | el

A Hot Tickets - administrator @ AP al | ; Aok ROl TR Tarei
o Select template Asanti. ST Bt View Vindow Hep  Aem |
e Enter Hot Ticket Name: Manual New Layout Hot Ticket _
placement‘ Create StoreFront Hot Tln:%'t S
Company name: -
e Select the Printer. )
Hot Ticket name:  Manual placement

3. Click Open.

The Hot Ticket automatically opens Close At Printers  Anapurna M2050 %

in Layout editor. [ open || cancel

Log Off .. Cir+K

HOT TICKETS

Don’t upload files when this Hot Ticket is opened in Layout editor.
Don’t create additional sheets in a Hot Ticket.
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eIl Workflow automation Hot Tickets

4. Change the required settings in:
e Job-Setup > Media inspector. Select the following settings:
0 Media: Generic
0 Size: 850x1300mm.

0 Quality: Standard. Q. = | B | + |23
e Job-Setup > layout Sheets inspector. Job Set-up
0 Make sure that Automatically place images on sheets is not selected: In the = 7z % @ I
resulting jobs, images will not be placed automatically on a sheet. Layout Sheets
e Job-Setup > Finishing inspector. Select e.g. the following settings: Harizontally
o Cutter: Ziind [Single sheet per Printer Layout v]
0 Finishing margins: iCut Corner marks, between 5. Vertically
e Color Management inspector. Select e.g. Color Management Simulate. Single row
e Job-Setup > Preflight inspector. Select e.g. Asanti Fixes from the drop down list. L ayeut Tnages
e Job-Setup > Job Identification inspector. IW
o If wanted, you can still change the Hot Ticket name. Optimize orientation
O Enter e.g. a remark “This is my remark”
5. Submit Job ’ ' Q. [ | & + |
e Choose Print Files: Make and hold Job Set-up
0 ‘Hold’ will put the resulting jobs in hold before the render. A /% i J_h
0 ‘Make and hold” will put the resulting jobs in hold after the render. Hot Ticket Identification
0 ’‘Make and send to printer’ will automatically output the resulting jobs. MName:

e Choose Cut Files: Make and send to cutter. Manual placement

0 ‘Hold” will not automatically output the cutting files for the resulting jobs.
0 ‘Make and send to cutter’ will automatically output the cut files for the resulting jobs.

When images are placed manually on the sheets, these ‘Print & Cut Files’ options are used as default when you click the Submit Job’ button.
When images are placed automatically on the sheets, the resulting jobs will automatically process according to the ‘Print & Cut Files’ options.
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Import images
1. In Windows explorer, browse to \\[YOUR ASANTI
SERVER\Hotfolderroot\Manual placement
2. Copy files to Hot Ticket Name folder: Woman with grapefruit
493x740.jpg and Asanti Box_Pantones.pdf.
3. Another way to input a file to a Hot Ticket is by dragging the file
to the Hot Ticket in Asanti: drag ASANTI Visual  Hot Ticket

||,|1 - Mame

390x250.pdf to the Hot Ticket. For each

2

[E‘[']" Manual placg
document that is copied to the Hot Ticket, a job
“

is created. All jobs automatically process the
documents until they arrive in the image panel. The jobs are in
an idle state.

Output a job

1. Click the Jobs link at the bottom of the client window to

navigate to the Jobs window

2. Edit job Woman with grapefruit 493x740. This opens Layout
Editor. The settings in the Job-Setup inspectors are set the same
as in the Hot Ticket (e.g. Finishing inspector > Cutter = Ziind).
Drag the image on the Sheet.
4. Submit job, Print Files: Make and Hold, Cut Files: Make and send

to cutter.

w

Preparing jobs to be merged

1. Edit job Asanti Box_Pantones to open the Layout Editor.

2. Select the image in the Image pane.

3. Select the Image inspector.

4. Change number of copies to 10 (1).

5. In the Finishing settings, edit Content element Frame (2).

6. Change Content Element (3) to PANTONE 1635 C and click OK.
7. Submit job, Print files: Make and Hold.

Generic

wa Lioranes T Asanti Box_Pantones.pdf

T ASANTI Visual 390:250.palf
Acanti vienal 1200737 inn

Q. 8 + | @

Image

Asanti Box _Paptonesndf
Copies: | 10 1
Sizer 300w 300 mm
Finishing ' BA Assign Finishing Cperation
Conkent Element
7 Content Element:] | () PANTONE 1635 C 3 v
Operation: %, Through Cut v
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Merge jobs
1. Inthe jobs list select jobs Asanti Box_Pantones and Asanti | Job Mec
Visual 390x250 (use SHIFT OR CTRL key to select multiple jobs). = &j Manual placement
2. Context-click the selected jobs > Merge jobs. % T ASANTI Visual 390% 250
3. Specify the Job Name and order number in the Merge Assistant. £ [ AsantiBo;  Archive Jobs
4. Click the Merge Jobs button to open the Layout Editor. T i Woman w
[Merge Assistart .l W Dl omaticou  Bxport b
Select jobs to be merged \santi vis Delete Jobs
| | |nrder |Jnh |Fn'd1€dﬂy |S|hnithed{h |Pmd.x1‘ e
?gf 28| Manual placement Asanti Box_Pantones Today, 13:18 Unbound Flat - single-sided Voman w
?g} 28| Manual placement ASANTI Visual 390x250 Today, 13:18 Unbound Flat - single-sided \sant Bo: Select Al
Q| [l | b )
i Hold Jobs
I Jobs to be merged: 2 out of 2 (ignoring 0 unsupported jobs)
Total pages/parts: 22
Merge Jobs... %
Merged Jobs Merger job .
[ |Delete: Use Job ticket from: Job "Asanti Box_Pantones” Job Name:  my new job name
I After days Order Mumber:  merged jobs
) =
| @ Immediately Close ] [ Merge Jobs J

5. Sheet > Auto Layout Images...
Select Type: True-Shape Nesting.
7. Click Auto Layout 2 Image(s).

e Asanti Box_Pantones is placed 10x,

o

e Spot PANTONE 1635 C (= the Through Cut Operation) is used for the nesting.
e Asanti Visual 390x250 is placed 1x.

8. Submit job, Print Files: Make and hold, Cut Files: Make and send
to cutter.

9. Close Merge Assistant.
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Hiding merged (original) jobs 54l Job Filter — .
1. Context click the Custom Filter at the —
left side of the jobs list and choose Edit. E Jen 1234 HRC 2zl
2. Click the Clear All button. [ = s
3. Enable checkbox for a merged job. [ g [No new documents in Page Store
4. Set dropdown list for merged job to Is B [ [Hasal pages
Not. E] M |Is Not on hold
5. Click OK. |
The merged (original) jobs are now T i |15 et i srer
hidden (Asanti Box_Pantones and Asanti
Visual 390x250). &1 |1s Mot - | @ merged job
4 (x) NO CUSTOM FILTER i (xl CUSTOM FILTER ENABLED
Show all 48 Job Shaw all 48 Job
@ m. EE [E" my new job name @ m. EE| [E" my new job name
ﬁ Anspurna M2050i Ty [ woman with arapefruit 493x740 ﬁ Anapuma M205Di Gy, [ woman with arapefruit 433740
— - %t | [ ASANTI visual 390250 — ®
e (¥ Asant Box_Pantones
¥ Custom Filer 4 ¥ Custom »ﬁ v

6. Click on Custom filter to disable the filter again

Hiding merged (original) jobs doesn't mean that they are removed from the system.
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Automatically delete merged (original) jobs

1. Inthe jobs list select jobs Asanti Box_Pantones and Asanti
Visual 390x250 (use SHIFT OR CTRL key to select multiple jobs).

2. Context-click the selected jobs > Merge Jobs.

3. Enable Delete Immediately in the Merge Assistant.

Jobs to be merged: 2 out of 2 {ig

Total pagesjparts: 22

Merged Jobs
Delete:
) After days
@ Immediately

Enter job name second combined job.

Click the Merge Jobs button to open the Layout Editor.

Place the images on the sheet.

Submit job, print files: Make and send to printer, cut files: Make
and send to cutter.

8. Close the Merge Assistant.

When the job second combined job is finished, the original jobs
are automatically deleted (Asanti Box_Pantones and Asanti
Visual 390x250).

No ok~
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2. Hot Tickets for automatic image placement Ol. % & +
. Job Set-up
Create Hot Ticket vl
1. Click the Hot Tickets link at the bottom of the client window to ! [ lD
navigate to the Hot Tickets window. e
2. Context click the previously created Hot Ticket >Duplicate Horizontally
ticket. The new Hot Ticket automatically opens in Layout editor. |Single sheet per Printer Layout -
3. Change the settings in: Vertically
e Job-Setup > Layout Sheets inspector. |Single row -
0 Check Automatically place images on sheets: In the resulting jobs, images will e
automatically be placed on a sheet.
0 Check Optimize orientation: When placing the image on the sheet, Asanti tries to A”tf’"?am?l? place mages on sheets
auto-rotate the image on the sheet for best fit. i
| . Optimize orientation . Don't Optimize
Sheet Sheet Sheet ~ Sheet
l - . Shi l l -
Sheet Sheet Sheet Sheet

4. Submit job.
e Enter a new name for the Hot Ticket: Automatic Output.

e Print Files: Make and send to printer.
e Cut Files: Make and send to cutter.
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Import images

1.

o &

© N

12.

13.

14.

In Windows explorer, browse to \\[YOUR ASANTI
SERVER]\Hotfolderroot\Automatic output.

Copy files to Hot Ticket Name folder: text boards 4 pages.pdf,

Asanti visual 1200x797.jpg and Asanti Box.pdf.

e For each document that is copied to the Hot Ticket a job is created.

e Al jobs automatically output and get a finished state.
After the jobs are output, edit job text boards 4 pages
e Each image is placed on a separate sheet.

Job Media Flows
= ‘ﬁ Automatic Output
v ¥ Asanti Box e |3
v’ f* Asanti visual 1200797 b |
« ¥ text boards 4 pages 4 (%)

e The settings in the Job-Setup inspectors are set the same as in the Hot Ticket (e.g. media size, quality, cutter,,...).

e Cutter registration marks are placed around each image (Finishing inspector > Cutter= Ziind).

e The image on sheet 2 is rotated 90°. Because optimize orientation is enabled in the Hot Ticket, Asanti rotates portrait shaped

images 90° if possible.
Submit job and click Discard.
Edit job Asanti visual 1200x797.
The image is rotated, otherwise it doesn’t fit on the sheet.
Submit job and click Discard.
Edit job Asanti Box
Select the image in the image pane
Click the image inspector, automatically spots are
recognized and assigned to finishing operations.

. Submit job and click Discard.
. In Windows explorer, browse to \\[YOUR ASANTI

SERVERI\FinishingRoot\Ziind.

For each job, finishing files are created, this is because
cutter Ziind was used.

Open Asanti Box_Sheet 1.pdf in Acrobat. This file contains
cutting info for Crease and Through Cut.

Close Acrobat

H— o
&-I:aybut Editor - Asanti Box (Autcmatic output) - Elﬂl!

Fle  Edit Amange

| Print Layouts (1)

Sheet  View

Window  Help

Images 1/1

® -

(1
.

Asanti Boo, pdf
271.4 x 231.6 mm

Finishing 4

Content Element Operation |

O Crease Crease

m O Cut ThI'DI..Igh Cut &
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3. Hot Tickets with frames

Create Hot Ticket

1.
2.

® NGk

Create a new Layout Hot Ticket from template Asanti.

In Layout Sheets inspector, enable automatically place images
on sheets. The optimize orientation option doesn’t influence
placement of images when frames are placed in the Hot Ticket.
In the finishing inspector, select Cutter: Ziind, Finishing
Margins: iCut Corner Marks, between 5.

Select the Frame tool. R kR QB e ¢+ | & U 1 113
Draw a frame on the sheet.

Select the Selection tool. R k U Q o 4 (2 U 1| 1139w
Select the frame.

Set the frame to X: 15mm, Y:15mm, o7 X: 15mm @@W 500 mm

W: 500mm, H: 300mm. 5 ¥: 15 mm H: 300 mm

Context click Frame > Fitting > Fitting Options.

e Set cropping to 0 mm.

e Enable Auto-fit Image to Frame (Fill frame with image).
e Enable Maintain proportions.

e Enable Rotate for better fit: Asanti checks the aspect
ratio’s (portrait or landscape) of the image and the
frame, and places the image so that the amount of
scaling or cropping is minimal.

Rotate for better fit OFF

Fitting

Rotate for better fit ON

Auto-fit Image to Frame

Scale: ’FiII Frame with Image ']

Maintain proportions

Crientation: Rotate for better fit

Align:

r
I
L

F[+[4

1
-
;|

frame
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10. Click OK to save the Fitting Options.

11. Draw another frame on the same sheet. i 550 mm W: 250 mm Fitting
. . 408 &3
12. Set the frame to X: 550mm, Y: 200mm, - prmy— o 120 mrm [¥] Auto-fit Image to Frame

W: 250mm, H: 150mm.
13. Set fitting options to :

Scale: [FiII Frame with Image -

["] Maintzin proportions

e 0 mm croppin N
pping Orientation: 7] Rotate for better fit

e Enable Auto-fit Image to Frame (Fill frame with image), |
Align:
e Disable Maintain proportions ’

e Disable Rotate for better fit.

ET'I
Fl+4
LjLl|d

v

14. Click OK to save the Fitting Options.

15. Select the marks inspector. Around the image block, Cutter
registration marks are shown because cutter “Ziind” is selected.

16. Manually enable the mark set “Cutter info”. All marks placed in
the Hot Ticket will also appear in the resulting jobs.

17. Submit job.
e Enter Hot Ticket name: Frames.

e Choose Print Files: Hold, Cut files: Hold.

Import images
1. Copy file to Hot Ticket: text boards 4 pages.pdf. ——
2. Edit job text boards 4 pages. e

e Each image is placed 2x on a separate sheet
e The images are placed using the fitting options of the frames.

'D?G‘tﬂ an the renawned Apoges

(40
S ASANTI
Offering a dedicated option

e Page 2 is automatically rotated in the right frame on sheet 2. This is because
“Rotate for better fit” is enabled in the fitting options of this frame. The
image is placed so that the amount of scaling or cropping is minimal.

e The settings in the job-setup inspectors are set the same as in the Hot Ticket (e.g. media size, quality, cutter, finishing margins,...)

e Cutter registration marks are placed around each image (Because selected cutter= Ziind)
3. Submit job and click Discard.
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4. Save Hot Ticket as template

A Hot Ticket can be saved as template, so when creating another new
Hot Ticket, the saved template can be used to start from.
1. Context click a Hot Ticket > Save as template.

Hot Ticket Media Flows h

0r FramMES1 Generic E | Today,
[fj:rI Automatic Output  Generic = & Today, |
[E_]j" Manual placement  F===== Ie=1i— -y
] Save as Template...
[r Asantisa7 Copydd
Export Hat Ticket PPD...
[ Asantisa7 Copy
[jr Asantisazf { Upload Document...
1 P

2. Create a new category: My category.
3. In the name field keep the default name, click save

It is not possible to save a Hot Ticket template in the categories: All, Asanti and Blank.

File>New layout Hot Ticket.

Choose My category.

Choose the saved template.

Enter a new Hot Ticket name, click open

The Hot Ticket opens with the same settings as in the Hot Ticket
template.

9. Submit the Hot Ticket>Delete.

©® NG
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